
 Instrument Express Mode in Custom Login 

Express Modes

1. Introduction 

Express Modes

The MACSQuantify™ Software includes a number of data 
acquisition and analysis tools that have been developed 
for an optimized and automated measurement of cells 
stained with Miltenyi Biotec reagent kits, e.g. MACS® Control 
Antibody Cocktails or Enrichment and Enumeration Kits. 
These Express Modes simplify flow cytometric analysis 
via predefined experiment settings as well as acquisition 
and analysis templates. Moreover, Express Modes apply an 
automated gating strategy to your cells of interest that will 
be automatically adjusted for each data file individually to 
achieve optimal results.

MACSQuantify Software login

MACSQuantify Software provides two user interfaces that 
you can use for your flow cytometric analysis:
•	 Express Login
•	 Custom Login
Both logins allow users to perform complex analyses 
fast and independently by providing Express Modes for 
predefined experiments. The Express Login provides a 
simplified interface and has been designed for use with 
predefined analysis templates. The Custom Login is 
designed to fit the needs of advanced users. In this mode, 
the user can change any settings of an Express Mode to 
adjust it to user defined conditions. 

Sample grouping function in MACSQuantify Software

The sample grouping function in MACSQuantify Software 
allows the user to save more than one sample within one 
data file. For Express Modes, this is relevant for protocols 
that require a gate to be applied from one sample to 
another. In Express Modes that use a control staining 
sample it is mandatory to group the samples. 

Note: When not using the Express Modes, the grouping 
function can be also used for combining two or more samples, 
for example, when measuring volumes larger than 450 µL.

Grouped samples can be ungrouped after acquisition and 
analyzed individually if desired. Ungrouped samples can be 
analyzed manually, however they cannot be analyzed by an 
Express Mode that requires grouped samples.

2.  Execution of Express Modes  
not using grouped samples

1.  Log into software. 
Use the Custom Login. Make sure the instrument is in 
acquisition mode (bottles are illuminated and system 
status displays “Acquisition mode”). 
For optimal results of the Express Modes it is important 
to perform recommended calibration and 
compensation of the instrument.

2.  Load instrument settings. 
Click the Open button or use 
the menu bar (file → open) to 
open an instrument settings 
file. Choose an applicable 
setting for the measurement 
from the Instrument settings 
tab (see fig. 1). For the creation 
of an instrument settings file 
please refer to the MACSQuant 
Instrument user manual.

Figure 1: Loading of instrument settings
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(Optional) Check and set the trigger to the correct channel 
(for requirements refer to the according data sheet). For 
example, MACS® Control stained samples will be measured 
with a CD45-VioBlue® trigger, whereas samples stained 
with other kits (e.g. EPC Enrichment and Enumeration Kit, 
human) will be measured with a FSC trigger. To select the 
channel for the trigger, click the Channels tab (see fig. 2). 
Consult with the data sheet for trigger requirements.

Note: For instrument settings requirements, refer to the 
relevant MACS Control Cocktail or kit data sheet. When 
using a Chill Rack, only select one single instrument setting. 
Express Modes are optimized for measurements with hlog 
axis settings. Refer to the MACSQuant Instrument user 
manual for information on setting axes.

Figure 2: Select the channel for the trigger to be used  
by checking the trigger button.

3.  Select sample rack. 
Select the rack type from the Rack pull-down menu in 
the Experiment tab (fig. 3). 
For Chill Racks, define the rack positions that contain 
your samples by marking them with a mouse click.

Figure 3: Selection of rack type.

4.  Select an Express Mode. 
In the Settings tab, click on the Express button, then 
select Analysis from the Type pull-down menu and 
chose your desired Express Mode from the Mode 
pull-down list (see fig. 4). 
By the selection of the Express Mode all experiment 
settings are loaded automatically. In Custom Login the 
loaded values are shown in the respective fields in the 
Experiment tab.

 
Figure 4: Selection of  Express Figure 5: Loaded parameters of  
Mode. the Express Mode MC_CD14_h.

5.  Enter the Sample ID and Description. 
Use the Sample ID and Description fields to enter 
relevant sample information.

6.  (Optional) Changing of predefined experiment settings. 
The Custom Login allows you to change the default 
experiment settings defined by the Express Mode. This 
might be necessary in cases where the recommended 
protocol has been changed, e.g., sample volume has 
been changed from the kit recommendations (see fig. 6). 

  Note: Changes to the Express Mode settings can affect 
the analysis calculations. For example, if the sample 
uptake volume is reduced, there may not be enough 
events in the sample for an accurate analysis.

Figure 6: Change of default settings, e.g., flow rate and uptake volume.

7.  Start the measurement. 
Click the Start Measurement button ( ) to start 
acquisition and analysis. The acquisition page defined 
by the selected Express Mode will appear on the screen 
after acquisition starts. After acquisition the Express 
Mode will proceed automatically to the analysis. When 
measuring with the single tube rack the analysis page is 
shown on the screen until a new measurement is started. 
All relevant information (acquisition page, analysis page, 
type of Express Mode) are saved within the data file and 
do not have to be saved separately.

8.  Backup data files. 
Click the Backup button ( ) to backup data files. For 
detailed data backup information please refer to the 
MACSQuant Instrument user manual.

9.  For analysis of Express Mode data on a separate PC 
proceed with 4. Analysis of Express Mode data files on 
computer.



3.  Execution of Express Modes  
using grouped samples

1.  Log into software. 
Use the Custom Login. Make sure the instrument is in 
acquisition mode (bottles are illuminated and system 
status displays “Acquisition mode”). 
For optimal results of the Express Modes it is important 
to perform recommended calibration and compensation 
of the instrument.

2.  Load instrument settings. 
Click the Open button or use the menu bar (File → Open) 
to open an instrument settings file. Choose an applicable 
setting for the measurement from the Instrument settings 
tab. For the creation of an instrument settings file please 
refer to the MACSQuant Instrument user manual (see fig. 1). 
Check and set the trigger to the correct channel (for 
requirements refer to the according data sheet). For 
example, MACS Control Cocktail stained samples will be 
measured with a CD45-VioBlue trigger, whereas samples 
stained with other MACS Assay (e.g. EPC Enrichment and 
Enumeration Kit, human) will be measured with a FSC 
trigger. To select the channel for the trigger, click the 
Channels tab in Custom Login (see fig.2). Consult with 
the data sheet for trigger requirements. 

  Note: For instrument settings requirements, refer to the 
relevant MACS Control Cocktail or kit data sheet. Using a 
Chill Rack you can only select one single instrument setting. 
Express Modes are optimized for measurements with 
hlog axis settings. Refer to the MACSQuant Instrument 
user manual for information on setting axes.

3.  Select sample rack. 
Select the rack type from the Rack pull-down menu in 
the Experiment tab (see fig. 3).  
For an Express Mode using grouped samples Chill Racks 
must be selected. 

4.  Define sample positions. 
Mark the rack positions that contain your samples by 
clicking on them. Group the desired sample positions 
by using the group button. Grouped samples will be 
assigned the same group number (see fig. 7) . 

  Note: Do not group more positions than sample IDs 
available (see information in corresponding kit data 
sheet). Only rack positions that are adjacent and in 
columns can be grouped. 

Figure 7: Rack positions A1 – D1 have been assigned to group 1  
by using the group function.

5.  Select an Express Mode. 
In the Settings tab select Analysis from the Type 
pull-down menu and chose your desired Express Mode 
from the Mode pull-down list (see fig. 4). By the selection of 
the Express Mode all experiment settings are loaded 
automatically. In Custom Login the loaded values are shown 
in the respective fields of the Experiment tab. (see fig. 5).

6.  Fill in sample information. 
The sample IDs are applied on the rack positions according 
to the predefined order in the Sample ID pull-down menu 
(see fig. 8). To enter additional user defined information, 
use the description field. Please note that only one 
description may be assigned per group of samples. 

7.  (Optional) Changing of predefined experiment settings. 
The Custom Login allows you to change the default 
experiment settings defined by the Express Mode (see fig. 6).  
For example, the sample IDs that were applied in the 
default order may be switched to reflect the sample 
positions in the Chill Rack. To change a sample ID, activate 
the sample well in the rack view and choose a Sample ID 
from the pull-down menu (see fig. 8). Avoid double 
assignments of sample IDs within a group of samples as 
this interferes with the subsequent analysis. Some Express 
Modes require the selection of mandatory sample IDs,  
e.g. “Control” in the Express Mode MC_CD34_CD133_h. 

  Note: Changes to the Express Mode settings can affect 
the analysis calculations. For example, if the sample 
uptake volume is reduced there may not be enough 
events in the sample for an accurate analysis.

Figure 8: In order to change the default sample IDs activate the sample 
well and choose a sample ID from the pull-down menu.

8.  Start the measurement. 
Click the Start Measurement button ( ) to start 
acquisition and analysis. The acquisition page defined by 
the selected Express Mode will appear on the screen after 
acquisition starts. After acquisition the Express Mode will 
proceed automatically to the analysis. The analysis page is 
shown on the screen until a new measurement is started. 
All relevant information (acquisition page, analysis page, 
type of Express Mode) are saved within the data file and 
do not have to be saved separately. 

9.  Backup data files. 
Click the Backup button ( ) to backup data files.  
For detailed data backup information please refer to the 
MACSQuant Instrument user manual.

10.  For analysis of Express Mode data with a PC proceed  
with 4. Analysis of Express Mode data files on computer.



4.  Analysis of Express Mode data files 
on computer

1.  Analysis of data files in Custom Login. 
Open the data file and call up its submenu by right 
clicking on the file name. Select View with express.
Analysis.<name of the Express Mode> for accessing 
the analysis template. The analysis will be displayed  
on the screen.

Figure 9: Excerpt from an analysis screenshot in Custom Mode  
user interface with the MC_CD34_CD133_h Express Mode.

In case you would like to change a gated region after analysis 
of the Express Mode data file, you can drag and drop it in the 
dot plot. In case of a grouped data file that links the regions 
within the single files a pop up window will ask you whether 
you want to apply the change only to the current single 
sample or to all grouped samples.  
If adjustments to the gated regions are required, ensure  
that the A analysis button is not activated. 

Example: You move a region on Original fraction (in 
MC_CD34_CD133_h Express Mode data file) and you click 
on Current, the region move only takes place on Original 
fraction. The corresponding linked regions on Control, 
Negative fraction, and Positive fraction are unaffected. 
Moreover, the moved region on Original fraction is 
unlinked from the other regions. When you click All the 
region move will be applied to the corresponding regions  
of all grouped samples within this data file.

5. Troubleshooting

1. Failure during Express Mode definition for acquisition.

Warning window will appear when selecting an Express 
Mode for grouped samples in case of:
•	 no	Chill	Rack	selected,
•	 sample	positions	not	grouped,
•	 	more	sample	positions	grouped	than	sample	IDs	available.

Note: Sample positions that are not adjacent in columns or 
rows cannot be grouped.

2. Failure of analysis.

Warning window will appear after measurement in case of:
•	 	double	assignment	of	sample	IDs	in	grouped	Express	

Mode data files,
•	 no	(or	very	few)	events	measured,
•	 	not	enough	events	measured	in	rare	cell	Express	Modes	

(for detailed information see according data sheet).
•	 	MACSQuantify	Software	on	PC	is	set	to	the	wrong	instru-

ment configuration. Go to Edit -> Configuration to select  
the configuration that was used to acquire the data file.
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